Why do citation styles matter?

Any academic research project must include accurate documentation of the resources consulted. This means providing information about your sources so your reader can locate them. If you examine articles in research journals, you’ll notice that they always include a list of references, with publication information.

Documentation in research projects has two basic features:

1. At the end of your paper or presentation, include a list of the resources you used. The list must be on a separate page at the end of your paper with the title “References” centered at the top of the page. Each entry, or citation, in the list provides information about the individual source. Citations are listed in alphabetical order, starting with the author’s last name. If a source has no author, the entry is alphabetized by title. Citations are double-spaced with hanging indents. There are specific rules for punctuation and italics in a References list, illustrated by the examples in this guide.

2. Each time you refer to a source in the text of your paper, include the last name of the author or the first few words of the title of the source (enough to identify it in your list of References) and the publication date, as close to the paraphrase or quotation as possible. (See the section on In-Text References for examples.) These references lead your reader to the appropriate entry in your References List.

How can this guide help me?

This brief guide provides examples in the APA style for information sources most commonly used by DMACC students. It should always be used in conjunction with the 6th edition of the Publication Manual of the American Psychological Association and information provided by DMACC instructors. Appropriate page numbers from the handbook are documented with each example in this guide. You may also want to visit the APA website at http://www.apastyle.org/. Finally, don’t forget—your librarians are always ready to help with citation questions!

This guide contains several sections:

- References: Books (2-4)
- References: Articles (5-7)
- References: DMACC Library Databases (8-9)
- References: Web Sites (10-11)
- Formatting Your Paper (12-15)
- In-Text References (16-17)
- Using Citation Tools: NoodleTools (18-22)
- Using Citation Tools: Word 2007 (23-30)
- Sample List of References (31-32)
- Credits (33)
Books

What pieces of information do I need to cite a book? (202-205)

- Author's or editor's name (last name, initial(s)),
- Year of publication, in parenthesis
- Title of the book (italicized)
- City of publication
  - Only include the state if the city is not easily recognized
  - Name of the publisher

It’s usually best to take this information from the title page of the book (front and back) rather than the cover.

Sometimes, you need to include additional information, such as the edition of the book or the specific pages you are citing.

How do I cite a book with one author? (203)


How do I cite a book with two to seven authors? (202)


How do I cite a book with more than seven authors? (184, 198)

Author A. A., Author B. B., Author C. C., Author D. D.,
  Author E. E., Author F. F., … Author J. J. (Year).
  *Title of work.* Location: Publisher.
Books

How do I cite a book with one editor? (202)


How do I cite a book with two editors? (202)


How do I cite a book with a corporate author? (202)


How do I cite an electronic version of a book? (203)


How do I cite a multivolume work? (204)


*Note: Use this format only when you used two or more volumes and you want to cite the entire work.*

How do I cite a second or later edition of a book? (203)

**Books**

**How do I cite a book chapter? (204)**


**How do I cite part of an edited book (anthology or collection)? (204)**


*Note: This entry includes the page numbers of the chapter or section cited.*

**How do I cite an encyclopedia entry? (204)**


**How do I cite an online encyclopedia entry? (205)**

**What is a periodical?**

A periodical is any publication that appears on a regular basis, such as a daily newspaper, a weekly or monthly popular magazine, or a scholarly journal published three or four times a year. Articles from periodicals are excellent resources for student research projects.

**What pieces of information do I need to cite an article? (198-202)**

- The author's name (last name, initial(s))
- Year of publication, in parenthesis
- The title of the article in quotation marks
- The name of the publication in italics
- The volume number (if known), in italics
- The page numbers of the article
- The digital object identifier (DOI) assigned to the article, if available
- If no DOI is available, include the URL for the article publisher. Use this format: Retrieved from http://www.xxxxxxx (do not place a period at the end of the URL)

**Scholarly versus popular: what’s the difference?**

Traditional popular materials include newspapers and magazines, such as *The New York Times* or *Newsweek* magazine. While these publications serve a very important purpose, instructors will often require students to use scholarly resources for their research projects. Journals are the most common place to find scholarly information. They include articles written by experts that are often reviewed and critiqued by other experts before they can be published.

**How do I cite an article from a popular magazine? (200)**


**How do I cite a newspaper article? (200)**


*Note: Precede page numbers for newspaper articles with p. (if the article is on one page), or pp. (if the article continues on an inside page). Note that the section number is included with the page number.*

**How do I cite an online newspaper article? (200-201)**


How do I cite an article in a scholarly research journal without DOI? (199)


How do I cite an article in a scholarly research journal with DOI? (198-199)


What is DOI?

DOI stands for Digital Object Identifier. It is a string of numbers and letters that serve as a permanent “address” to digital objects such as journal articles. URLs are constantly changing and therefore serve as an inefficient way to locate digital information over the long term. Using a DOI instead of a URL in a reference list prevents users from encountering broken links and dead ends when recovering sources from a reference list.

DOI is administered by the International DOI Foundation. Individual DOIs are assigned to individual objects by the publisher at the time of publication, and they never change. A DOI will link readers directly to the object in question (or information about how to access the object) no matter where the object currently resides or how many times it has been moved.

CrossRef.org is a website that helps researchers and students locate missing and check existing DOIs. Use their website (www.crossref.org) to look up a DOI for an article, to verify an article’s DOI, or to find an article using its DOI.

In APA references lists, DOI takes the place of changeable resource information (such as URLs). It eliminates the need for retrieval dates. Use DOI information whenever available, both for electronic resources and print resources.

How do I cite a book review? (209)

How do I cite an article with no author? (200)


How do I cite an article with two to seven authors? (198)


How do I cite an article with more than seven authors? (198)

Gilbert, D. G., McClernon, J. F., Rabinovich, N. E., Sugai, C., Plath, L. C., Asgaard, G., ... Botros, N. (2004). Effects of quitting smoking on EEG activation and attention last for more than 31 days and are more severe with stress, dependence, DRD2 A1 allele, and depressive traits. Nicotine and Tobacco Research, 6, 249-267. doi: 10.1080/14622200410001676305

How do I cite an online magazine article? (200)

What pieces of information do I need to cite an article from a database? (198-202)

Citations for articles and other documents from subscription services databases will normally include the same information you would have in a citation to a print source, plus the document’s DOI information. You do not have to include information about which database you used to find the article, or when you first retrieved it. The basic elements of a citation for an online article include the following:

- The author’s name (last name, initial(s))
- The year of publication, in parenthesis
- The title of the article, in quotation marks
- The name of the periodical (italicized)
- The volume number (if known), in italics
- The page numbers of the article
- The digital object identifier (DOI), if available
- If no DOI is included, use CrossRef (www.crossref.org) to try to look up the DOI information for the article
- If CrossRef yields no results, look up the website for the publisher and include the URL in your citation. Do not look for the specific page containing the article; only include the publisher’s main or home page.

Note: Some databases will try to provide ready-made citations for their resources. Be cautious with these, as many are not up to date with the latest set of APA guidelines, and other often contain mistakes.

How do I cite an article from an EBSCOhost database (Masterfile Premier, Academic Search Elite, etc.)?


How do I cite an article from a Thomson Gale database (Academic OneFile)?

How do I cite an article from a Proquest database (*Des Moines Register*)?

Editorial: Make sure students will be ready for college


How do I cite a report from the CQ Researcher database?


*Note: This article has no DOI listed in the database and a search on CrossRef returned no results. Include the website for the database in cases such as this.*

How do I cite an article from an OCLC FirstSearch database (PsychFirst, Books in Print, Medline, etc.)?


How do I cite a NetLibrary book?


How do I cite an article from the Encyclopedia Americana database?

What pieces of information do I need to cite a Web site? (187-192)

Citations for web sites may include any or all of the following:

- The name of the author, compiler, corporate author or editor of the work
- The publication or update year, if known, in parenthesis
- The title of the document, in italics (capitalize only the first word of the title and any names of people or places)
- The title of the page, if the document is part of a larger Web site
- The retrieval statement giving the electronic address, or URL, of the site, with no period or other additional punctuation

In reality, many websites will not include all of the information you would find in a print source or subscription database document. If you cannot find some of the information, cite what is available. If there is no publication date, use the abbreviation n.d. in place of the year.

How do I cite a general website? (187-192)

<table>
<thead>
<tr>
<th>Citation</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>American Association of Community Colleges website:</td>
<td><a href="http://www.aacc.nche.edu/Advocacy/aginitiative/Pages/default.aspx">http://www.aacc.nche.edu/Advocacy/aginitiative/Pages/default.aspx</a></td>
</tr>
</tbody>
</table>
How do I cite Wikipedia? (187-192)

Note: While using Wikipedia for basic information is often helpful, citing it on an academic research paper is generally not recommended.

How do I cite a podcast? (210)

How do I cite a blog posting? (215)

How do I cite presentation slides found online? (209-210)

How do I cite a government document found online? (216-224)

Note: This document is a presidential proclamation retrieved from GPO Access, a free online government database.


How do I cite an online video? (209)
What should my final paper look like? (21-59)

The APA Handbook recommends that all research papers adhere to certain formatting guidelines. Be sure to check with your instructor to verify these guidelines with his/her own preferences and requirements. All APA-style papers should include four major components:

1. Title page
2. Abstract
3. Text
4. References page

Your title page should include:

- A header beginning with the phrase Running head: and followed by the title of your paper in all capital letters. The header should also include a page number in the upper right corner.
- The title of your paper, centered on the page
- Your name
- The name of your school or institution (Des Moines Area Community College, for our purposes)

Begin your abstract on the second page. Include the following:

- The word Abstract, centered at the top of the page
- A short, one paragraph summary of the contents of your paper. This text should be double-spaced.

Use the following formatting guidelines throughout your paper:

- Use 1” margins
- Double-space the entire text, including quotations and your references
- Use 12pt, Times New Roman font

See pages 41-59 of the APA Handbook for sample papers.
Learning to be Information Literate in the Information Age

Jenna M. Ehler

Des Moines Area Community College
Abstract

An abstract is a summary of your research paper. It should be about one paragraph in length. An abstract is a summary of your research paper. It should be about one paragraph in length. An abstract is a summary of your research paper. It should be about one paragraph in length. An abstract is a summary of your research paper. It should be about one paragraph in length. An abstract is a summary of your research paper. It should be about one paragraph in length.
### Sample Paper: Body

**LEARNING TO BE INFORMATION LITERATE IN THE INFORMATION AGE**

Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text (Baldwin, 2007).

Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text. Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text Research text. Research text Research text Research text Research text Research text Research text Research text Research text (Levin, Kater, & Wagoner, 2006). Research text Research text Research text Research text.
What are in-text references and how do I use them? (174-179)

Within the text of your paper, you must show your reader exactly what you borrowed from each source you paraphrase or quote, and exactly where in the source you found the material. These are your in-text, or parenthetical, references.

Your in-text references must clearly point to sources in references list, except in the case of personal communications (discussed on the following page). Usually the author’s last name and the publication date is enough. In some cases, you may need to include page numbers as well. If a source has no author, use the title, shortened or in full.

An original passage from the preface (page xix) of the book *The Community College Experience: Plus* by Amy Baldwin, published in 2007 by Pearson/Prentice Hall is shown below, with examples of different types of in-text references.

**Full citation:**


**Original passage:**

“Education can improve your life by increasing your understanding of yourself and the world around you. The more you know and understand other people, cultures, and yourself, the better able you are to influence your community in a positive way. Knowing more about yourself also improves your self-esteem and personal happiness. Moreover, higher education gives you the lifelong learning skills necessary for your health and well-being.”
Paraphrase with the author’s name in the text:

Baldwin (2007) points out that higher education improves a person’s quality of life in several ways.

Paraphrase with the author’s name in the parenthetical reference:

Higher education provides benefits that improve overall quality of life (Baldwin, 2007).

Direct quote with the author’s name in the text:

According to Baldwin (2007, p. xix), “higher education gives you the lifelong learning skills necessary for your health and well-being” as well as other benefits.

References to personal communications:

In APA style, the list of references includes information about recoverable data only. Personal communications are not recoverable by your reader, so they are cited only in the text of your paper. When you refer to a personal interview, a phone conversation, or other personal communication, give the initials and last name of your source, a descriptive phrase describing the communication, and as exact a date as possible. For example:

According to librarian P. Mumma (personal communication, March 15, 2010), students can get help finding information for research projects in several ways.

DMACC students can get help for research projects in person, by phone, or from the library website (P. Mumma, personal communication, March 15, 2010).
What is NoodleTools?

NoodleTools is an online tool that can help you format your bibliography page and allows you to save and organize the references for books and articles used for your research assignments. It is accessible from home and campus through the DMACC library website. For further assistance, contact a DMACC librarian.

First Step—Create a Personal ID by registering at the main NoodleTools page. Access NoodleTools through the DMACC library website and click on the link for NoodleTools. Creating an account in NoodleTools is beneficial for two reasons: 1) You can begin your list now and come back to it later, no matter where you are or what computer you are using. 2) You can create more lists in the future, as you continue your studies at DMACC and have additional research projects.

Click on the “Create Personal ID” button to get started.
Generate your References page. When you are finished typing your paper and entering your sources, you can automatically generate a References page that presents all the sources in the correct format and layout, according to APA rules. To create your References page from previously saved sources, follow these steps:

1. At the end of the text of your paper, add a new page by completing one of the following processes:
   - Press <Ctrl + Enter>
   - OR
   - Click Page Break on the Insert tab
   - OR
   - Click Blank Page on the Insert tab

2. Center your cursor using the Align Text Center button in the Paragraph group on the Home tab. Type the words References at the top of the page.

3. Press Enter and click the Align Text Left Button to move your cursor to the left margin.

4. Click the References tab and click the Bibliography button in the Citations & Bibliography group.

5. Select Insert Bibliography to insert the list of sources for your References page.
You will need a “School/Library Password” to access the sign in page. Ask your librarian for the password.

Once you enter the password you will see a “New User Registration” form. Fill out the form by answering the questions and creating a Personal ID of your choice. Your Personal ID and password should be something easy to remember. It is recommended you use your DMACC user name and password.
Once you have created your Personal ID, you can start entering references by creating a new project. Each class or research project you are working on can have its own list. Start by clicking on the “Create New Project” button at the top right hand side of the page.

Next, select your citation style. Choose APA Advanced. Enter a name for your list in the description box and click “Create Project” at the bottom of the page to get started.
The next screen you will see is a new function called the Dashboard. Here you can work on many aspects of your project: your thesis statement, your research question(s), even the text of your paper (using GoogleDocs). You can also share your project with a teacher or librarian to receive assistance and/or feedback.

To access your References list, click Bibliography, located in the Components group.

Create a citation for your References list by selecting a citation type from the pull down menu. The most common citation types used by DMACC students are online journals and books. Ask a librarian for help if you need assistance figuring out what citation type is needed for your source. Once the citation type is selected, click the “Create Citation” button to continue. From here, NoodleTools will walk you through the steps to build the proper citation for your source. If you have any questions about or during the process, please contact a DMACC librarian.
Finished? Now generate your References Page

Once you have entered all the citations needed for your paper or project, review each citation in the list for errors. From the References Page in NoodleTools you can edit or delete citations by clicking on the options to the right of each entry.

Generate a References page in Microsoft Word by clicking on the Save as Word Doc button at the top of the page.

Select the Export & Print button. A file download box will appear. Select Open and your References page will open in Word in a new window.

Print your page or save it to your P: drive or to removable media (such as a flash drive).
You can also use Word 2007 to create and manage a References page as you write the text of your research paper. It is a little different workflow than NoodleTools, so let your librarian know if you need additional help. Here’s how to get started citing sources in Word 2007:

**Select a citation style.** Choose APA from the drop-down menu under the References tab.

**Enter sources.** Word will keep track of all the bibliographic information you supply as you assemble your resources. You can choose to enter all of your sources at the beginning of your project, or enter them as you write the text of your paper. You will only need to enter the basic information once. After that, Word will store the information and you can use it as many times as you need.

To add a source, follow these steps:

1. Place the cursor in the body of your paper where you need to insert an in-text reference.
2. Click the References tab, then click the Insert Citation button in the Citations & Bibliography group.
3. Select Add New Source
4. Enter the source information in the dialog box.
5. Click OK. An in-text reference is inserted in the document where the cursor is located. The source is also saved, so it can be cited again in the document and included in the References list.
Formatting your bibliography

Caution: Word 2007 does not always automatically follow the formatting guidelines of APA style. Once you have added your list of sources to your References page, be sure to check the following formatting concerns:

1. Select the text of your list of sources (but not the References title) and place your mouse over the Hanging Indent marker (the lower triangle) on the ruler.
2. Drag the Hanging Indent marker to the 0.5” mark on the ruler.
3. With the text of your list of sources still selected, reset the line spacing by clicking on the Line Spacing button on the Paragraph group in the Home tab, and select 2.0.
4. With the text of your list of sources still selected, click the Line Spacing button and click Remove Space After Paragraph.
5. Check the titles of your sources. Word will most likely underline all titles of books and other larger works. APA rules specify that all such titles should be italicized instead of underlined. Be sure to change all underlines to italics, using one of two tactics:
   - Highlight the text in question and press <Ctrl + U> to remove the underline. With the text still highlighted, press <Ctrl + I> to italicize.
   - Highlight the text in question and press the U button on the Home tab to remove the underline. With the text still highlighted, press the I button on the Home tab to italicize.

Examples:

**Formatting a citation for a book:**
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a *Book*. This formatting is correct as is.

**Formatting a citation for a chapter from an ebook:**
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this source into Word as a *Web site*. This formatting is correct as is.
**Formatting an article from a newspaper:**
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as an Article from a Periodical. This formatting is correct as is.

**Formatting a citation for a newspaper article from a database:**
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as an Article in a Periodical. You must make the following edits:
- Add the phrase Retrieved from and the URL of the publisher
- Do not add information about the database or the date you retrieved the article

Your final citation should look like this:


**Formatting a citation for an article from a popular magazine:**
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as an Article in a Periodical. This format is correct as is.

**Formatting a citation for a Web site:**
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a Web site. Enter American graduation initiative as the name of the Web page and American Association of Community Colleges as the name of the Web site. This formatting is correct as is.
Formatting a citation for an article from a scholarly journal with DOI:
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a Journal Article. You must make the following edits:
- Insert the article’s DOI if the information is available. Place the DOI at the end of your citation.

Your final citation should look like this:


Formatting a citation for an article from a scholarly journal without DOI:
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a Journal Article. You must make the following edits:
- Insert the phrase Retrieved from and the publisher’s URL immediately following the page numbers

Your final citation should look like this:

Formatting a citation for a journal article from a database:
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a Journal Article. You must make the following edits:
- Remove the space between the volume number (28) and the issue number (1)
- Add the DOI information for the article, if available.
- Do not add information about the database or the date you retrieved the article

Your final citation should look like this:

doi: 10.1111/j.1465-7287.2009.00173.x

Formatting a citation for a blog posting:
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a Web site. The following edits must be made:
- Change the title of the posting from italics to plain text
- Add the phrase Web log post in square brackets between the title and the period following the title

Your final citation should look like this:
Formatting a citation for an article from Wikipedia:
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a **Web site**. You must make the following edits:
- Change the title of the entry from italics to plain text
- Insert the retrieval date after the word Retrieved, followed by a comma

Your final citation should look like this:


Formatting a citation for a video from YouTube:
In the Word 2007 Citation Manager, your citation will appear like this:


Enter this resource into Word as a **Web site**. You must make the following edits:
- Change the title of the video from italics to plain text
- Insert the phrase Video file in square brackets between the title and the period

Your final citation should look like this:

Using Word 2007 for In-Text References

See the section of this guide devoted to In-Text References for more detailed information. For the following examples, refer to this full citation and original passage:

Full citation:


Original passage:

“Education can improve your life by increasing your understanding of yourself and the world around you. The more you know and understand other people, cultures, and yourself, the better able you are to influence your community in a positive way. Knowing more about yourself also improves your self-esteem and personal happiness. Moreover, higher education gives you the lifelong learning skills necessary for your health and well-being.”

EXAMPLES

Paraphrase, author’s name in the text:

Baldwin (2007) points out that higher education improves a person’s quality of life in several ways.

In this instance, you would not employ the Word Citation Manager. Simply type the author’s last name, and add the parenthetical reference to the publication date.

Paraphrase, author’s name in parenthetical reference:

Higher education provides benefits that improve overall quality of life (Baldwin, 2007).

To use the Word Citation Manager, click on the button labeled “Insert Citation” at the point you wish to add your parenthetical reference. Word will insert the correct parenthetical reference, as seen above.

Direct quote, author’s name in text

According to Baldwin, “higher education gives you the lifelong learning skills necessary for your health and well-being” as well as other benefits (2007, p. xix).

Again, as with the paraphrased reference, you would not employ the Word Citation Manager. Type the author’s last name in the text, and add the parenthetical reference to the publication date and the page from where the quote was taken.
References


Sample list of References


This document was adapted from the following DMACC resources:

- Documenting Sources: A Brief Guide to APA Style for DMACC Student Writers (© 2010)
- Creating a Research Paper in APA Style (© 2009)
- MLA Style (© 2010)

Additional information and examples from: